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1 Inleiding 

 
Deze handleiding is ontwikkeld om u vertrouw te maken met de belangrijkste functies van het 
vergader, training en conferentieplatform van HILIS Web Communicatie. De handleiding zal u instaat 
stellen om een online bijeenkomst te op te zetten, te starten en uit te voeren. Het document kan ook 
worden gebruikt als naslagwerk, om na te bepalen hoe bepaalde functies precies werken. Voor meer 
diepgaande informatie of instructies kan ook gebruik worden gemaakt van de online Help files. Deze 
zijn toegankelijk vanuit de virtuele vergaderruimte, door op Help > Help Topics (help bestanden) te 
klikken. 
 
Opmerking bij het gebruik van de handleiding: 
Alle dik gedrukte woorden en uitdrukkingen in de tekst refereren naar functies en menu’s van de gebruikersinterface. 
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2 Snel aan de slag 

 
In dit hoofdstuk wordt in een aantal korte stappen aangegeven hoe u kunt starten met het gebruik 
van de diensten van HILIS. Er zal worden uitgelegd hoe u zich kan registeren, hoe tijd te kopen, hoe 
een sessie te in te stellen en hoe deelnemers uit te nodigen. De hoofdstukken die daarna volgen 
zullen dieper op de functies ingegaan. 

2.1 Registeren en tijdkopen 

 
Voor de toegang tot de diensten van HILIS Web Communicatie dient men te surfen naar onze 
website. Start Internet Explorer1  en surf naar www.hilis.nl. Klik op Diensten om op de pagina te 
komen waar u toegang kunt krijgen tot alle verschillende elementen van de dienstverlening. 

 
Om aan de slag te gaan dient u in het bezit te zijn van een Account bij HILIS. Indien u nog geen 
account hebt, kunt u geheel gratis een account aanmaken door te klikken op Open een nieuw 
Account.  
 

                                           
1 De diensten van HILIS zijn uitsluitend te gebruiken in combinatie met Windows Internet Explorer. 
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Hiermee wordt het bovenstaande formulier geopend, waarin u uw naam, bedrijfsnaam en andere 
contactgegevens invult.  
U dient eveneens een wachtwoord in te vullen. Dit wachtwoord geeft later toegang tot uw account. 
Met dit wachtwoord bent u de beheerder van uw account. U bent hiermee in staat om tijd bij HILIS in 
te kopen. Voor beveiligen van uw gegevens en het account is het van belang om te kiezen voor een 
veilig wachtwoord. Een wachtwoord met een combinatie van letters en cijfers garandeert een zeker 
niveau van veiligheid. 
 
Door een klik op de Submit knop wordt uw account aangemaakt.  
 
Opmerking: Deelnemers aan uw Internet sessie hoeven geen account aan te maken. 
 

2.2 Tijd inkopen 

 
Hilis hanteert een transparant en eenvoudig prijsmodel. Alleen de kosten voor het gebruik van de 
diensten in rekening worden gebracht. Er zijn dus geen additionele kosten aan de diensten 
verbonden. Als u kiest voor een gebruikerstegoed aan uren, dan is het minimum aantal uren dat u 
kunt inkopen 5 uren. Zodra u tijd hebt ingekocht, kunt u direct starten met een bijeenkomst.  
 
Om tijd in te kopen, klikt u op de koppeling Tijd inkopen. Dit vindt u op pagina Diensten van de 
Hilis Website. Volgt daarna de instructies op het scherm. Voor de betaling kunt u gebruik maken van 
een credit card; Visa of Mastercard. Indien u een andere wijze van betaling wenst, kunt u daarover 
gerust contact met ons opnemen. Het betalen via de Website van Hilis is veilig, wij passen hetzelfde 
niveau van beveiliging voor de transacties toe, die ook door banken wordt gebruikt.  
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De gekochte tijd wordt niet verbruikt als u alleen als Host (Voorzitter) in de vergaderruimte bent. Dit 
stelt U in staat om zonder kosten een sessie te openen en al vast een presentatie of de lesstof voor te 
bereiden. Kosten worden in rekening gebracht, zodra uw deelnemers zich hebben aangemeld voor de 
sessie. 
 

2.3 Een bijeenkomst configureren 

 
Hebt u al een account bij HILIS, dan kunt u inloggen door te klikken op Log-on. Deze koppeling kunt 
u vinden op de pagina Diensten van de HILIS Website. Na het inloggen of aanmelden kunt u via 
Start een bijeenkomst de eerste stap doen voor het configureren van de virtuele vergaderruimte.  
 
Hebt u een positief saldo op uw HILIS account, dan kunt u met een sessie starten. Hebt u geen saldo, 

of is het saldo niet toereikend, dan kunt u tijd inkopen met Tijd inkopen, zie paragraaf  2.2.  

 
Zodra u een positief saldo op uw account hebt, kunt u starten met een online sessie. Indien u de 
HILIS diensten voor de eerste keer gebruikt, of indien er een nieuwe versie van de software op de 
server staat, zal er een automatische download en installatie van de software starten. U kunt de 
instructies op het scherm volgen om de installatie correct uit te voeren. Het installatieproces zal 
meestal 1 tot 3 minuten in beslag nemen, afhankelijk van de snelheid van uw Internetverbinding. 
 
Na het starten van de software zal het HOST scherm verschijnen. In dit scherm worden de 
eigenschappen en de instellingen van de sessie bepaald en ingesteld. 
 

 
 

2.3.1 Room details 

 
Bij Room Details vult u de naam van uw bijeenkomst in. Indien gewenst kunt u een wachtwoord 
gebruiken. Met het wachtwoord kunt u bepalen wie toegang tot uw sessie kunnen krijgen. Het 
wachtwoord wordt ingevuld in het veld Meeting Room Password. 
 
U kunt kiezen uit een publieke of een privé (besloten) bijeenkomst. Bij een publieke bijeenkomst, 
Public Room, kan iedereen de vergaderruimte betreden. Voor het betreden van een besloten of privé 
bijeenkomst, Private Room, dient men over een wachtwoord te beschikken. Dit wachtwoord moet 
worden doorgeven aan uw genodigden. De bijeenkomst kan uitsluiten worden betreden met dit 
wachtwoord.  
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Indien u de optie  I want this room to be unlisted  selecteert, zal de bijeenkomst niet worden 
getoond op de pagina Live Events van de HILIS website. 
 

2.3.2 Host Details 

 
In de eerste kolom van Host Details registreert u de naam van de voorzitter (Host name), de naam 
van de organisatie (Organization), de plaatsnaam (City),  de provincie of regio (State),   de titel 
van de voorzitter (Title) en het telefoonnummer (Telephone) waar de voorzitter op is te bereiken. 
 
In de tweede kolom selecteert u bij Message Board, het elektronische prikbord dat u van te voren 
moet hebben gecreëerd, om documenten en berichten van de bijeenkomt te verspreiden. Voor het 

gebruik van het Message Board wordt verwezen naar paragraaf  10.2.  

 
In het veld Evaluation Form kunt u het evaluatieformulier selecteren, dat u voor uw sessie wilt 
gebruiken. Elke deelnemer die uw sessie verlaat zal automatisch dit evaluatieformulier krijgen.  
Hebt u meerdere accounts bij HILIS, dan kunt u bij Charge Time to aangeven op welke rekening 
(Account) de tijd moet worden belast.  
 
In het veld Meeting Duration kan een indicatie worden afgegeven voor de tijdsduur van de sessie. 
Dit veld is informatief. Overschrijding van de opgeven tijd zal niet leiden tot het beëindigen van de 
sessie.  
 
Participant Limit wordt gebruikt om het aantal deelnemers aan uw sessie te begrenzen.  
 

2.3.3 Overige Host instellingen 

 
De bezitter van het Podium is instaat alle functies in de presentatieruimte te gebruiken. Er kan maar 
een persoon in het bezit zijn van het Podium. Indien de optie Disable podium grabbing is 
aangevinkt, kunnen de deelnemers niet meer zelfstandig het Podium  overnemen. Alleen de 
voorzitter (Host) heeft nu daartoe de mogelijkheid.  
 
Door te klikken op More Options wordt het Room Setting venster geopend. 
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In dit venster kunt u de instellingen voor de deelnemers in de virtuele vergaderruimte of het online 

klaslokaal bepalen. Meer details kunt u lezen in paragraaf  6.4.2. 

Met Save Settings worden de instellingen bewaard. Deze zijn dan beschikbaar voor een eventuele 
volgende sessie.  
 
Met een klikt op Done wordt het scherm verlaten. U komt dan terug in het Host scherm. Met een klik 
op Start the Meeting (Start de Vergadering) krijgt u toegang tot de virtuele vergaderruimte. 
 
In de virtuele vergaderruimte kunt u meteen aan de slag. In het geval u nog weinig ervaring hebt met 
online vergaderen of soortgelijke bijeenkomsten, raden wij u aan om eerst rustig de mogelijkheden 
van het platform uit te proberen en uw presentatie te oefenen. 
De tijd die u alleen in de virtuele ruimte doorbrengt wordt niet in rekening gebracht. Zodra er een 
ander deelnemer in de ruimte komt, zal elke minuut dat deze aanwezig is van uw saldo worden 
afgetrokken.  
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3 Deelnemers uitnodigen en toegang verlenen 

 
In de vele gevallen zult u de deelnemers van uw online bijeenkomst al hebben uitgenodigd. U hebt 
dan een agenda verzonden en hierin is de aanvangstijd aangegeven. Om deel te kunnen nemen aan 
de online bijeenkomst, zullen de deelnemers verder moeten weten hoe zij toegang tot de sessie 
kunnen krijgen. In dit hoofdstuk worden de mogelijkheden om toegang te krijgen uiteen gezet.  
 

In paragraaf  3.1 wordt uitgelegd hoe u vanuit een sessie uitnodigingen naar deelnemers kunt sturen.  

 
Hebt u gekozen om uw bijeenkomst op de lijst van lopende sessie 

(http://www.hilis.nl/Live%20events.htm) in te nemen, dan kunt u in paragraaf  3.2 lezen hoe de 

deelnemers toegang kunnen krijgen.  
 
Voor het geval u gekozen hebt om de bijeenkomst niet op de lijst van lopende bijeenkomsten te 

zetten, wordt uitgelegd (zie  3.3) hoe de deelnemers toegang kunnen krijgen tot de sessie. 

 

3.1 Een deelnemer uitnodigen vanuit een sessie 

 
De meest eenvoudige manier om uw deelnemers uit te nodigen voor een bijeenkomst is door gebruik 
te maken van de Send Meeting Invitations functie. U vindt deze functie onder het menu Options, 
zoals aangegeven in de onderstaande afbeelding.  
 

 
 
Voer het e-mail adres van de genodigde in het bovenste veld in. U kunt dit adres ook vanuit een 
andere toepassing of bestand kopiëren en in het veld plakken.  Klik dan op de Add toetst om het e-
mail adres aan de lijst toe te voegen. Zodra de lijst compleet is, kan men door een klik op de Send 
Now toetst de uitnodigingen verzenden. Alle genodigden zullen dan een e-mail bericht ontvangen met 
daarin een instructie om in de bijeenkomst te komen.  
 
Met de Remove knop kan men e-mail adressen uit de lijst verwijderen. Met de Clear All knop wordt 
de gehele lijst geschoond. 
 

3.2 Toegang krijgen tot een bijeenkomst uit de lijst 

 
Deelnemers aan uw bijeenkomst kunnen toegang krijgen, door te gaan naar de website van HILIS 
(www.hilis.nl) en te klikken op Join Meetings & Events. Het onderstaande venster, Join Meetings 
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and Events, zal dan worden getoond. In dit scherm zijn de lopende bijeenkomsten weergegeven. 
Door te klikken op het veld Join achter de titel van uw bijeenkomst, kan men toegang verkrijgen.  
 

 
 

3.3 Toegang tot een bijeenkomst niet in de lijst 

 
In het geval u hebt gekozen om de titel van uw bijeenkomst niet te publiceren op de lijst van lopende 
bijeenkomsten, is de procedure om toegang te krijgen als volgt. 
 
Vanuit de website van HILIS (www.hilis.nl) gaat u naar de lijst van lopende bijeenkomsten door te 
klikken op Join Meetings & Events.  Rechtsboven het venster treft men de koppeling Join an 
unlisted meeting.  Door hierop te klikken zal een nieuw venster worden geopend waar het kenmerk 
van de vergadering (Meeting ID) en het wachtwoord kan moet worden ingevuld.  
 
De voorzitter kan het Meeting ID nummer als volgt terugvinden. Kies het menu Options en 
selecteer vervolgens Send Meeting Invitations. Door te klikken op het veld Copy Join link to 
clibboard wordt de informatie van de bijeenkomst geplaatst in het klembord van uw PC. Deze 
informatie bevat het Meeting ID, die kan worden geplakt in een e-mail bericht aan de genodigden. 
Het Meeting ID nummer treft met aan het eind van de regel aan. 
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4 De vergaderruimte 

 
De gebruikersinterface voor het organiseren, beleggen en uitvoeren van online trainingen, 
vergaderingen of andersoortige bijeenkomsten is ontwikkeld om het gebruik zo gemakkelijk mogelijk 
te maken. Daarom is het aantal knoppen, menu’s en keuzes tot een minimum beperkt.  
 
Om de meeste functie te kunnen gebruiken, dient men te beschikken over het Podium. Dit wordt 
aangegeven met een icoon (een spreker achter een katheder), achter de naam van een deelnemer.  

 
 
De functies van de gebruikeromgeving, zoals hieronder weergegeven, zijn gebaseerd op 3 principes, 

namelijk: Drop down menu’s ( 4.1), Tabbladen ( 4.2) en klikken met de rechtermuistoets ( 4.3). 

 
 

 
 
 
 

4.1 Drop down menu's 

 
Links boven treft men de van Windows toepassingen bekende drop down menu’s. Dit zijn de menu's  
File, Edit, View, Options en Help. Of in het Nederlands Bestand, Bewerken, Beeld, Extra en 
Help. 
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Onder File treft men alle functies voor het werken met bestanden. In paragraaf  6.1 kunt u meer 

hierover lezen.  
 

Het Edit menu heeft functies voor bewerkingen op het White board. Zie paragraaf  6.2 voor meer 

informatie hierover.  
 
Bij View zitten alle functies voor het instellen van de layout van de virtuele vergaderruimte. Zie 

paragraaf  6.3. 

 
Met Options kan men de instellingen voor de gebruikers van de sessie bepalen. Zie meer hierover in 

paragraaf  6.4 

 

Het Help menu wordt verder besproken in paragraaf  6.5. 

 

4.2 De Tabbladen 

 
Boven het presentatiegebied vindt men een viertal Tabbladen. 
 
De Tabbladen zijn in de onderstaande afbeelding weergegeven.  
 

 
 

Met de Tab White Board gaat men naar het White Board, voor meer hierover zie paragraaf  10.1. 

Met de Tab Message Board gaat men naar het Message Board, zie paragraaf  10.2. 

De Tab Web Board wordt verder beschreven in paragraaf  10.3.  

Meer informatie over het Chat Board is te vinden in paragraaf  10.4 

 

4.3 Klikken met de rechter muistoets op de naam van de deelnemer. 

 
Het klikken met de rechtermuis toetst op de naam van een deelnemer, creëert de mogelijkheid om 
een aantal specifieke functies voor een deelnemer in te stellen. Meer hierover is te lezen in paragraaf 

 7.6. 
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5 Audio instellingen  

 
Vele Web conferentiesystemen maken voor het overdragen van de spraaksignalen gebruik van een 
externe teleconferentie brug. Bij het platform van HILIS Web Communicatie is een Voice over IP 
component toegevoegd, waardoor men direct via één omgeving aan de slag kan gaan.  
 
Bij het eerste gebruik van de audio functie op een PC, is het meestal noodzakelijk om de audio 
instellingen aan te passen. De deelnemers die voor het eerst deelnemen, zullen eventueel ook uw 
hulp nodig hebben om de instellingen te optimaliseren.  
 
Rechts van het midden boven in het beeldscherm treft u het Audio Icoon. Deze icoon geeft een 
indicatie van het niveau van het audiosignaal. 

  
 

5.1 Activeren van de audio 

 
Om te beginnen dient u eerst de audio te activeren. Dit wordt gedaan door te klikken op het vlak voor 
uw naam in de deelnemerslijst. Bij het klikken met de rechtermuis toets zal een icoon van een 
microfoon in het veld verschijnen. Bij het klikken met de linkermuis toets verschijnt er een icoon van 
een headset. Spreken met de headset is slecht mogelijk, door te klikken op de Talk knop. Voor het 

gebruik en de verdere uitleg van de Talk knop wordt verwezen naar paragraaf  7.1.3. 

 

 
 

5.2 Het instellen van de audio 

 
Wanneer er is gekozen voor de microfoon, zullen de groene, gele en rode vlakken in het audio icoon 
veranderen, zodra u in de microfoon spreek Deze gekleurde vlakken geven de indicatie van het audio 
volume. Indien u normaal spreekt, zullen uitsluitend de groene vlakken en zo af en toe een geel 
zichtbaar moeten zijn. Als er een rode vlak verschijnt, is dit het teken dat het audio volume te hoog is 
ingesteld. Door op het audio icoon te klikken, wordt het venster om de audio instellingen te wijzigen 
(Audio Settings) geopend. 
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In dit venster kan het volume van het inkomende audio signaal (Volume Control) en het uitgaande 
audio signaal (het eigen microfoon signaal) (Microphone Control) worden ingesteld. Men kan tevens 
kiezen uit de verschillende drivers die op de PC voor de audio zijn geïnstalleerd.  
 

5.2.1 Het instellen van het inkomende audiosignaal 

 
In het veld Device kan een driver worden geselecteerd van het randapparaat voor de weergave van 
het geluid op de PC. In de meeste gevallen zal dit de driver van de geluidskaart in de PC zijn. In het 
Volume veld kan het volume van de geluidsweergave worden ingesteld.  
 
Met de Audio Delay functie is de lengte van het Audio vertragingsbuffer in te stellen. Hiermee kan 
afhankelijk van de condities van het Internet voorkomen worden dat er fragmenten uit de spraak 
wegvallen. Bij een goede Internetverbinding kan de vertraging op een lagere waarde worden 
ingesteld. Bij een verbinding van mindere kwaliteit kan het voorkomen dat er fragmenten uit de 
spraak wegvallen. Door het vergroten van de vertraging (delay) kan dit worden voorkomen. 
 

5.2.2 Het instellen van het uitgaande audiosignaal 

 
In het Device venster kunt u een driver voor de microfoon selecteren. Dit zal in de meeste gevallen 
de driver voor de geluidskaart in de PC zijn. Het ingangsniveau kan worden ingesteld in het Volume 
veld. Het volume zal zo moeten worden ingesteld, dat bij het spreken in de microfoon de indicatie van 
het audiosignaal in het Audio indicatie icoon niet in het rood gaat. 
Als u beschikt over een headset dient u het vakje “I am using a microphone headset”  aan te 
klikken. Er wordt daarin een vinkje gezet. Indien u geen headset gebruikt dient u er voor te zorgen 
dat dit vlakje niet is aangevinkt. Anders zal dit een storende echo veroorzaken. De microfoon zal dan 
het signaal uit uw luidsprekers oppikken en dit signaal weer verzenden naar de overige deelnemers, 
wat een storende echo tot gevolg zal hebben. 
 
De individuele audio instellingen kunnen worden getest door te klikken op de knop Microphone Test. 
Na het spreken van 5 seconde in de microfoon, kunt u uw ingesproken audiosignaal beluisteren. U 
hoort nu het audiosignaal, zoals die door het systeem wordt verzonden.  
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5.2.3 Overige Audio instellingen 

 
U kunt door te klikken op Multimedia Settings of op de iconen van de microfoon of de luidspreker in 
het Audio Settings venster alle overige audio-instellingen van uw computer bekijken of wijzigingen. 
 

5.3 Instellingen activeren en opslaan 

 
Klik op Done om de auto-instellingen te activeren en te bewaren voor een volgende sessie.  
Met het klikken op Cancel zullen de instellingen niet worden geactiveerd en ook niet worden 
opgeslagen. 
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6 De gebruikers menu's 

 
De gebruikersinterface voor het organiseren, beleggen en uitvoeren van online bijeenkomsten is 
ontwikkeld om het gebruik zo gemakkelijk mogelijk te maken. De bij Windows toepassingen bekende 
File, Edit, View, Options en Help menu’s of in het Nederlandse Bestand, Bewerken, Beeld, Extra 
en Help,  zijn te vinden boven de deelnemerslijst, links boven in het beeldscherm. Sommige menu’s 
zullen grijs zijn. Dat houdt in dat zij voor de specifieke gebruiker niet beschikbaar zijn.  
 

6.1 Het File menu 

 
Het File menu bevat voornamelijk functies voor het presenteren op het White Board.  
 

 
 
De eerste keus onder het File menu leidt tot de Present, Show, Send  functies. Hieronder bevinden 
zich de volgende keuzes:  
 
Present, Show, Send, wat onderverdeeld is in:  

• Show a Picture; Hiermee kan men een foto op het White Board weergeven. 
• Present a PowerPoint slide show; Hiermee kan een PowerPoint presentatie worden 

gegeven. 
• Present an Image slide show; Hiermee kan zoals bij een dia presentatie een reeks foto’s op 

het White Board worden weergegeven, die zich allen in één file bevinden.  
• Present Multimedia; Hiermee kan men een multimedia bestand (video en geluid) weergeven. 
• Screen-cast; Hiermee kan men het Bureaublad en alle op de PC aanwezige toepassen aan de 

overige deelnemers tonen. 
• Send a File; Hiermee kan met een bestand naar de overige deelnemers verzenden. 

 
Save Picture kan worden gebruikt voor het verzenden van een bestand naar alle deelnemers die zich 
in de sessie bevinden. 
 
Met de Print functie kan men afbeeldingen afdrukken, die zich op het White Board bevinden. 
Met Exit wordt de vergadersessie verlaten. 
 

6.2 Het Edit menu 

 
Onder het Edit menu bevinden zich de functies:  
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Copy Picture; Hiermee wordt een kopie van de afbeelding op het White Board opgeslagen in het 
klembord van de PC. 
 
Paste Picture; Hiermee wordt de inhoud van het klembord van de PC geplakt op het White Board; 
 
Restore Picture; Indien een afbeelding op het White Board is voorzien van markeringen, 
aantekeningen of iets dergelijks, dan kunnen die worden verwijderd door deze functie. 
 

 
 

6.3 Het View menu 

 
Met de View functie kan de indeling van de virtuele vergaderomgeving worden aangepast. 
 

 
 
Met Full Screen wordt de presentatieruimte over het gehele beeldscherm getoond. 
 
Indien Show Group Chat control niet is aangevinkt, wordt het Groep Chat scherm niet getoond. 
 
Met het aanvinken van Show Webcam control wordt het Webcam scherm weergegeven. 
 
Onder de keuze Windows Styles bevindt zich een aantal mogelijkheden om de lay-out van de 
omgeving aan te passen. 

6.4 Het Options menu 

 
In het menu Options treft men een aantal functies waarmee de vergaderstructuur en de 
mogelijkheden voor de deelnemers kunnen worden ingesteld. 
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6.4.1 Send Meeting Invitations 

 
Met Send Meeting Invitations kunnen deelnemers worden uitgenodigd voor het deelnemen aan de 
bijeenkomst. 
 

 
 
De e-mail adressen worden in het eerste veld ingevuld. Men kan de adressen ook kopiëren uit een 
bestand of andere bron en deze in dit venster plakken.  
Met een klik op de Add knop wordt het adres in het send venster gezet. Is de lijst van genodigden 
compleet, dan kunnen de uitnodigingen worden verzonden, door een klik op de Send Now knop. Alle 
geadresseerden ontvangen dan een bericht met de benodigde gegevens om in de sessie te komen. 
Met Remove kan een selectie van adressen uit de lijst worden verwijderd.  
Met Clear All wordt de gehele lijst leeg gemaakt. 
 
Met Copy Join link to clibboard kan de link naar de sessie worden gekopieerd naar het klembord 
van de PC. Hierin treft men informatie om toegang te krijgen tot de sessie. Men treft daar onder meer 
het Meeting ID. Die is nodig indien een deelnemer via de website toegang wil krijgen tot een sessie 
die niet op de lijst van lopende sessies is gepubliceerd. 
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6.4.2 Room Settings 

 
In het Room Settings menu kunnen de instellingen van alle deelnemers in de virtuele 
vergaderruimte worden bepaald.  
 

 
 

• Allow people to private chat with each other; Indien dit is aangevinkt, kunnen de 
deelnemers met elkaar een privé chat doen. 

• Allow people to “grab” the podium; Indien dit is aangevinkt, kunnen deelnemers zelf het 
podium nemen. In het andere geval kan de toegang tot het podium door de voorzitter 
worden verstrekt. 

• Allow people to erase the White Board; Indien aangevinkt, kunnen deelnemers het White 
Board schoonvegen.  

• Allow people to doodle on the White Board; Indien aangevinkt, kunnen deelnemers teken 
en schrijven op het White Board.  

• Restrict participants to view only mode; Indien aangevinkt hebben de deelnemers geen 
communicatie over en weer in de bijeenkomst.  

• Allow people to "grab" the microphone;  Indien aangevinkt, kunnen deelnemers zelf de 
microfoon pakken. Anders moet de microfoon door de voorzitter worden doorgegeven.  

• Participant must provide BOTH first and last name; Indien aangevinkt moeten de 
deelnemers bij het ingaan van de bijeenkomst zowel de voornaam als de achternaam opgeven. 
In het andere geval moet de deelnemer een naam of eventueel een bijnaam opgeven. 

• Participant must provide e-mail address; Indien aangevinkt, moet de deelnemer een e-
mailadres opgeven.  

• Participant must provide organization and title; Indien aangevinkt, moet de deelnemer de 
organisatie naam en titel opgeven.  

• Participant must provide city / state; Indien aangevinkt, moet de deelnemer zijn 
woonplaats gegevens opgeven.  

• Participant must provide phone number; Indien aangevinkt, moet de deelnemer zijn 
telefoonnummer opgeven.  

 
• Auto-select Sync Tabs when podium is passed; Indien aangevinkt zal de Sync Tabs 

functie aanstaan. Hiermee wordt bij het doorgeven van het podium automatisch ervoor 
gezorgd dat alle vensters van de deelnemers synchroon zullen lopen met die van de 
presentator (de houder van het podium (default is checked). In het andere geval zullen de 
deelnemers zelfstandig naar andere gebieden in de ruimte kunnen navigeren.  
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• Auto-select Sync URL when podium is passed; Indien aangevinkt zal de Sync URL functie 
aanstaan. Hiermee wordt voorkomen dat deelnemers onafhankelijk van de presentator kan 
navigeren naar andere Internet pagina’s. 

 
• Done; Met het klikken op Done worden alle instellingen geactiveerd en het venster wordt 

gesloten.  
• Save Settings; Klik op deze knop om de instellingen te bewaren voor een volgende sessie.  
• Performance; Met een klik op deze knop wordt het Network Performance venster geopend. 

Zie voor een verdere beschrijving paragraaf  6.4.4 Network Performance.  

 

6.4.3 Audio Settings 

 
Met de keuze Options > Audio Settings kan men in een virtuele vergaderruimte de audio 
instelliingen van de lokale  PC wijzigingen.  

Zie voor een verder beschrijving hoofdstuk  5 Audio Instellingen. Daar treft men onder meer 

informatie voor het instellen van het volume van de lokale luidspreker en de instellingen van de lokale 
microfoon. 
 

 
 

6.4.4 Network Performance 

 
Met de Network Perfomance functie kan men de prestatie van de Internetverbinding en de Server 
voor de sessie worden geoptimaliseerd. De prestatie zal in de meeste gevallen verbeteren wanneer de 
instelling meer naar rechts is gezet. Echter indien de instelling te ver naar rechts is gezet kan dit 
afhandkelijk van de snelheid van de Internetverbinding gevolgen hebben op de spraak. Er wordt 
daarom aanbevolen een optimale instelling te zoeken, die past bij de snelheid van uw 
Internetverbinding.  
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6.4.5 View Only Mode 

 
In de View Only mode is tussen de deelnemers geen communicatie over en weer meer mogelijk. 
Deze optie kan uitstekend worden gebruikt bij grote bijeenkomsten. De interactiefuncties met de 
toehoorders wordt dan uitgezet.  
 
De functie is uiteraard alleen beschikbaar voor de voorzitter (Host) of vice voorzitter (Cohost) van 
een bijeenkomst.  
 
Deze optie is gewenst indien de presentator tijdens het geven van een presentatie niet gestoord wil 
worden.  
 
De View Only mode functie kan ook worden ingesteld in het “Room Settings” venster, zie 

paragraaf  6.4.2.  
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6.4.6 Lock the Meeting 

 
Met de functie “Lock the Meeting” kan de vergaderruimte worden vergrendeld, waardoor het voor 
nieuwe deelnemers niet meer mogelijk is toegang te verkrijgen.  
 

 
 

6.4.7 Show Received Files 

 
Met de functie Show Received Files kan elke deelnemer een venster openen, waarin de bestanden 
worden getoond die vanuit de sessie zijn ontvangen. Via Options > Show Received Files wordt een 
nieuw venster geopend, met daarin de bestanden die tijdens de sessie zijn verzonden.  
 
Een bestand kan worden opgeslagen door het eerst te selecteren en dan met een klik op de knop 
Save op te slaan. Geselecteerde bestanden kunnen ook van de lijst worden verwijderd, door een klik 
op de Remove knop. Het venster wordt gesloten door te klikken op Cancel. 
 

 
 

6.4.8 Meeting Recorder 

 
De voorzitter (Host) of vice voorzitter (Cohost) hebben beiden de mogelijkheid om een sessie op te 
nemen. De opname kan worden gestart door een vink te zetten voor Meeting Recorder in het menu 
Options.  
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De audio en video van de bijeenkomst zal dan worden opgeslagen op de PC, van waaruit de recorder 
is gestart. Zowel de Host als de Cohost kan tegelijkertijd en onafhankelijk van elkaar een opname 
maken en deze op hun lokale  PC opslaan.  
 
Wanneer een opname wordt gemaakt, zal er voor de EXIT knop rechtsboven in het scherm een 
flikkerende rode R verschijnen, ter indicatie dat de recorder is gestart.  
 
De opname kan worden gestopt door de klikken op de Meeting Recorder knop in het menu 
Options. De vink zal dan verdwijnen. Het bestand van de opname zal worden opgeslagen op het 
bureaublad van de PC. Het bestand zal de opname van de sessie bevatten tot op het moment waarop 
de opname is gestopt. De naam van het bestand zal zijn: Recording_nummer.avi. Zodra er een nieuw 
bestand opname wordt opgeslagen, wordt het nummerveld in de naam met 1 worden verhoogd. 
 
Het bestand wordt in .avi formaat opgeslagen. Dit is een formaat dat kan worden weergegeven met 
Windows Media Player of andere software, zoals Real Player. Het wordt aangeraden om de opname in 
het volledige scherm modus te bekijken, omdat de teksten anders onleesbaar zullen zijn.  
 
Het opnemen van een bijeenkomst kan een zeer groot bestand tot gevolg hebben.  Met de volgende 
instellingen kan men ervoor zorgen dat de file grootte wordt gereduceerd:  
 
Stel de kleuren resolutie van het scherm in op 16 bit (gemiddeld).Deze instelling is te vinden bij 
Eigenschappen voor Beeldscherm (rechtermuis op Bureaublad en dan Eigenschappen > Instellingen. 
Stel de schermresolutie in op 800x600 pixels. 
Een webcam produceert erg veel data. Dus als een stilstaand beeld van de presentator mogelijk is, 
heeft dat de voorkeur. Dit zal de omvang van het bestand drastisch verlagen.  
 

6.5 Het Help Menu 

 
Via het help menu wordt toegang verkregen tot de help bestanden. Onder dit menu treft men tevens 
de mogelijkheid om opmerkingen te maken of vragen te stellen aan de helpdesk.  
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7 Het deelnemers venster 
 

Links op het beeldscherm treft u het deelnemers venster of Participants grid. In het deelnemers 
venster, met de titel Particpants, vindt men de namen van de deelnemers die in de bijeenkomst zijn. 
In hetzelfde venster bevindt zich een aantal besturingselementen, dat zowel door de Host als de 
deelnemers zijn te gebruiken. 
 

 
 

7.1 Het activeren van de Microfoons 

 
Het veld links van de naam van een deelnemer wordt gebruikt voor het activeren van de microfoon 
van de betreffende deelnemer. Er wordt onderscheid gemaakt tussen een enkelvoudige en een 
meervoudige microfoon modus. Bij de enkelvoudige modus kan 1 persoon tegelijk spreken. In dit 
geval is een microfoon icoon in het veld zichtbaar. Bij de meervoudige modus is spraak met meerdere 
deelnemers tegelijk mogelijk. Dan is de icoon van een headset in het veld zichtbaar. 
 

7.1.1 Enkelvoudige microfoon modus 

 
Bij de enkelvoudige microfoon modus kan slechts 1 persoon de microfoon in bezit hebben. De overige 
deelnemers kunnen slechts luisteren naar degene die de microfoon heeft. Zij kunnen pas aan het 
woord komen, nadat zij de microfoon hebben. De voorzitter kan bepalen wie de microfoon krijgt. Dit 
wordt gedaan, door met de linker muistoets te klikken op het vak links van de naam van een 
deelnemer. Een icoon van een microfoon zal dan in het vak verschijnen. De microfoon kan worden 
verwijderd door met de linker muistoets op de icoon van de microfoon te klikken. 
 
Indien de optie “Allow people to "grab" the microphone”  bij de Room Settngs (zie pagagraaf 

 6.4.2) is ingeschakeld, kunnen de deelnemers zelf de microfoon pakken. Deze optie werkt het beste 

bij kleine bijeenkomsten. Het vereist echter wel de nodige discipline van de voorzitter en de overige 
deelnemers.  Men zal hierover vooraf afspraken moeten maken.  
 

7.1.2 Meervoudige microfoon modus 
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Door met de rechter muistoets op het veld links van de naam van een deelnemer te klikken, kan de 
voorzitter de betreffende deelnemer voorzien van een continue spreekfunctie. In het veld zal een 
icoon van een headset verschijnen. Indien de deelnemer geen headset heeft gekoppeld aan zijn PC zal 
er een kruis door de icoon zichtbaar zijn. Dit heeft verder geen gevolgen. De spraak blijft gewoon 
mogelijk. Gelijktijdig met het headset icoon zal er een Talk veld naast de Yes en No knop onder in 
het deelnemers verschijnen. Om te kunnen spreken dient eerst op de Talk knop gedrukt te worden.  

 

 
 

7.1.3 De Talk knop 

 
Zodra de voorzitter de headset heeft geactiveerd kan men de spreekfunctie aanzetten door op de 
Talk knop te drukken.   
  
Indien er gebruik wordt gemaakt van een headset zal de spreekfunctie na het indrukken van de Talk 
knop permanent geactiveerd zijn. Als er niet gebruik wordt gemaakt van een headset, of als de 

headset niet is geactiveerd in het Audio Setting venster (zie paragraaf  6.4.3), dient men de Talk 

knop ingedrukt te houden om te kunnen spreken. Met het indrukken van de Talk knop wordt het 
inkomende audiosignaal geblokkeerd. Hiermee wordt voorkomen dat er een echo ontstaat van het 
inkomende audiosignaal.  
 
De Talk knop kan bij gebruik van een headset ook worden uitgezet. Dit is een handige manier om de 
spraak tijdelijk op mute (uit) te zetten. Hiermee zullen de achtergrond geluiden de vergadering of het 
virtuele klaslokaal niet verstoren. 
 
Zodra er in de microfoon wordt gesproken, zal de achtergrond van het veld met de naam van de 
spreker geel worden. Hiermee kan de spreker zelf bepalen of de microfoon is geactiveerd. De 
voorzitter kan dit signaal ook gebruiken om te bepalen waar een echo eventueel vandaan komt. 
 
 

7.2 De Podium besturing 

 
Door te klikken op het veld rechts van de naam van een deelnemer, kan de voorzitter het podium 
aan de betreffende deelnemer geven. Indien de podium Grabbing functie “Allow people to “grab” 

the podium” in het “Room Settings”  venster is geactiveerd (zie paragraaf  6.4.2), kunnen de 

deelnemers zelf het podium nemen. De bezitter van het podium kan gebruik maken van alle 
presentatiefunctie. Bij het gebruik van een webcam zal het beeld van de podium bezitter actief 
worden. 
 

7.3 De hand opsteken 

 
Rechts naast het veld van het podium treft men het veld voor het opsteken van de hand.  
Door op dit veld te klikken kan elke deelnemer een signaal afgegeven om de aandacht te vragen, 
bijvoorbeeld om te kunnen spreken met een microfoon. De voorzitter kan daarop reageren, door het 
geven van de microfoon.  
 
Een presentator kan ook aan de deelnemers vragen de hand op te steken, bijvoorbeeld als teken dat 
men het met een bepaalde stelling of opmerking eens is. Elke deelnemer kan zijn eigen hand icoon 
verwijderen door daarop te klikken. De bezitter van het podium kan alle hand iconen in een keer 
verwijderen door te klikken op het hand icoon bovenin het deelnemers venster. 
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7.4 Yes/No Indicatie 

 
Bij het stellen van een vraag kunnen de deelnemers met het klikken op de Yes/No knoppen een “Ja”  
of “Nee” antwoord geven. De knoppen zijn te vinden onderin het deelnemers venster. Na het drukken 
van de Yes knop zal het podium veld achter de naam van de deelnemer groen kleuren. Bij het 
drukken van de No knop zal het veld rood kleuren. 
 
Onderin het deelnemers venster naast de Yes/No knoppen treft men de som van de personen die 
“Ja”  of “Nee” hebben gestemd.  De presentator, dit is altijd de persoon die in het bezit is van het 
podium, kan de kleuren en de Yes/No velden verwijderen en de som van de stemming weer op nul 
zetten, door dubbel te klikken op een van de velden van de som.  
 

7.5 Het uitvoeren van een opiniepeiling 

 
De presentator kan een opinieeiling houden door gebruik te maken van het Polling – Post a 
Question venster. Het venster wordt geopend door te klikken op het Private Polling icoon rechts 
onderaan het deelnemers venster (zie de zwarte pijl in de onderstaande afbeelding). 
 

 
 
De presentator kan vervolgens in het venster een vraag invoeren. Hij kan de vraag intypen of 
kopiëren uit een ander bestand en plakken. Met een klik op de Post the Question knop wordt de 
vraag aan alle deelnemers gepresenteerd. Het volgende venster (Please Answer Yes or No) zal dan 
op het scherm van de deelnemers verschijnen. 
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De deelnemers kunnen dan “Ja” of “Nee” stemmen door het klikken op de Yes/No velden of zich te 
weerhouden (Abstain) van een stem. 
 
Zodra er is gestemd zal het resultaat aan de presentator worden gepresenteerd in het Polling – 
Results venster 
 
De presentator kan met een klik op de Tabs, Poll en Results van het ene naar het andere venster 
gaan.  
 

 
 

7.6 Overige functies in het deelnemers venster 

 
Door het klikken op het veld met de naam van een deelnemer kunnen de voorzitter, maar ook de 
deelnemers de volgende instellingen wijzigen: 
 

• Toggle My Away Status; Hiermee kan men aangeven, dat men afwezig is. Het veld met de 
naam van de deelnemer zal grijs worden weergegeven.  

• Refuse Private Chats; Voor het weigeren van privé chats. Hiermee is het voor andere 
deelnemers niet meer mogelijk om met de betreffende deelnemer een privé chat sessie te 
doen. 

• Sounds; Voor het instellingen van geluiden voor het betreden en verlaten van de ruimte, het 
geluid bij het handopsteken en het geluid bij het uitvoeren van een nieuwe tekst chat. 

• Submit Feedback; Voor het geven van terugkoppeling aan support of de helpdesk.  
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7.6.1 De functies van de voorzitter 

 
 

 
 
 
Met de Host / Cohost Options  > Audio Playback (entire room) functie kan de voorzitter de 
buffer voor de audio vertraging instellen voor de gehele ruimte. Als alle deelnemers zijn gekoppeld 
met een breedband Internetverbinding en het audiosignaal klinkt zuiver, dan kan men de buffer 
verlagen tot een minimale waarde. Indien het geluid gefragmenteerd wordt overgedragen, 
bijvoorbeeld als gevolg van een slechte Internetverbinding, kan men de buffer het beste vergroten om 
de geluidskwaliteit te verbeteren. 
 
Met de Send File functie kan een bestand worden verzonden. Deze dezelfde functie is ook te vinden 

onder het File menu, zoals beschreven in paragraaf  6.1 en  10.1.5.  

 
Met de Toggle My Away Status kan de status op afwezig worden gezet. 
 
Het selecteren van Refuse Private Chats wordt het voeren van een privé chats geblokkeerd. 
 
Door het selecteren van de Sounds  optie kunnen geluidssignalen voor het betreden en verlaten van 
de vergaderruimte worden aan of uit gezet. Tevens kan worden bepaald of er een geluidssignaal 
wordt gegeven bij het opsteken van een hand of het starten van een tekst chat. 
 
Met de Submit Feedback functie  kan een bericht naar de support of helpdesk worden gestuurd. 
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7.6.2 De Privé Chat functie 

 
Door te klikken op het veld met de naam van een deelnemer kan men de privé chat functie activeren. 
Het Chatting with .. venster wordt op uw scherm geopend en zo ook op het scherm van degene 
waarmee u de privé chat wil uitvoeren.  Het is nu mogelijk om een privé chat te doen tussen u en de 
gekozen persoon. Door het selecteren van de Vioce Chat optie is het ook mogelijk om met audio te 
communiceren. Door hierop te klikken zal een Talk knop verschijnen zowel op uw scherm als op het 
scherm van degene waarmee u de privé chat uitvoert. De werking van deze Talk knop komt overeen 

met de Talk knop beschreven in paragraaf  7.1.3. 
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7.6.3 Overige functie voorzitter voor deelnemersinstellingen 

 

7.6.3.1 Individuele Restrict to view only mode 

 
Met de Restrict [naam deelnemer]  to view only mode functie kan de voorzitter kan elke 
willekeurige deelnemer beperken tot het uitsluitend volgen van presentaties. 
 

7.6.3.2 Host / Cohost Optie 

 
Met Host / Cohost optie is het mogelijk om aan elke willekeurige deelnemer alle functies en rechten  
toe te kennen die de voorzitter bezit. Klik met de muis op het veld met de naam van de deelnemer. 
Selecteer Host / Cohost Options  en klik vervolgens op de Promote to Cohost knop. 
 
In het Host / Cohost Options veld zijn verder nog de volgende functie beschikbaar: 
 

• Dismiss [naam deelnemer] from meeting: Hiermee wordt een deelnemer uit de 
vergaderruimte verwijderd. Het is voor de deelnemer niet meer mogelijk om aan de sessie deel 
te nemen.  

• Audio Settings for [naam deelnemer]: hiermee kan de voorzitter een aantal instellingen van 
de geselecteerde deelnemer wijzigen. 

• Request Remote Controle: Hiermee kan de voorzitter de besturing van de PC van een 

deelnemer overnemen. Deze functie is verder beschreven in paragraaf  10.1.8.  

• Send a File:  Met deze functie kan de voorzitter een file verzenden naar de geselecteerde 
deelnemer. 
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8 Groep chat 

 
Links op het scherm onder het deelnemers venster bevindt zich het Group Chat venster. Elke 
deelnemer die zich in de vergaderruimte bevindt kan chatten, door de tekst in het dialoog venster in 
te voeren. Met een klik op Send wordt de tekst naar alle deelnemers in de ruimte verzonden.  
De tekst chat functie is ideaal om te communiceren met mensen die geen microfoon ter beschikking 
hebben. Het is verder een perfect middel voor deelnemers aan de sessie om vragen te stellen tijdens 
een presentatie, zonder de presentator direct te interrumperen.  
Het is aan te bevelen als voorzitter of presentator dit veld steeds open te hebben. Zo kan men de 
vragen en het commentaar van de deelnemers direct zien.  
 
De tekst in het chat venster zal automatisch verschuiven. Met de pijlen is het mogelijk om de 
verborgen teksten weer te voorschijn te halen.  
 
Indien het Group Chat venster verkleind is, zal er een getal rechts van de titel van het venster 
verschijnen. Dit getal wordt steeds met een verhoogd, zodra er een nieuw chat bericht is ontvangen. 
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9 De Webcam 

 
Elke deelnemer kan zijn webcam activeren, door op de webcam tab en op de groene pijl onderaan 
het webcam  venster te klikken.  
Het webcam beeld van de deelnemer die in het bezit is van het podium zal naar de overige 
deelnemers worden verzonden.  
 

 
 
Met de Cam Settings  optie kunnen de webcam instellingen worden gewijzigd.  
 

9.1 Device instellingen 

 
De Device optie stelt u instaat om een driver voor de webcam te selecteren of een foto als stilstaand 
beeld in het webcam venster te laten zien. Met Load a Picture wordt een foto uit een bestand 
gehaald, zodat deze wordt toegevoegd aan de lijst van weer te geven stilstaande beelden in het 
webcam venster.  
En met Remove a Picture kan men een bestand uit de lijst van beelden verwijderen. 
 
 

9.2 Destination area instellingen 

 
Met de instellingen voor de Destination area kan worden bepaald, waar het webcam venster in het 
beeldscherm wordt weergegeven. Er zijn drie mogelijkheden: 
 

• Keuze 1, is de standaard  instelling, dat is links onderin het beeldscherm. 
• Keuze 2, is in het gebied van het White Board rechts onder aan het scherm. 
• Keuze 3, is de weergave centraal op het White Board. Bij deze keuze is het mogelijk om de 

resolutie van het beeld te vergroten to maximum 320 x 240 pixels. 
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9.3 De overige Webcam instellingen 

 

9.3.1 De Capture rate instelling 

 
Met de Capture rate instelling is de beeldfrequentie te bepalen. Men heeft de keuze tussen, 2 of 5 
beelden per seconde (every 2 or 5 seconds) of zo snel mogelijk (as fast as possible). Bij de 
laatste instelling wordt de beeldfrequentie aangepast op de beschikbare bandbreedte.  
 

9.3.2 De Size & pixel depth instelling 

 
De resolutie van het webcam beeld is te bepalen met de Size & pixel depth instellingen. Na het 
selecteren van deze optie zal het volgende venster worden geopend. 
 

 
 
De aanbevolen scherm resolutie is 176x144 pixels. Indien het webcam beeld in het centrum van het 
White Board wordt gepresenteerd kan ook een grotere resolutie worden gekozen, echter dit zal een 
grotere bandbreedte vergen, wat ten koste kan gaan van de totale performance.  
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9.3.3 Gamma, contrast & hue 

 
De Gamma, contrast & hue instelling kan worden gebruikt om de instellingen van het bronsignaal 
van de webcam te wijzigen. Deze instellingen zijn afhankelijk van het type webcam. 
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10 Het presentatie gebied 

 
Het presentatie gebied bevat 4 functie, het White Board, het Message Board, het Web Board en 
het Chat Board. Deze functies zijn onder de tabs bovenin het beeldscherm te vinden. Zij zijn 
ontwikkeld met het doel om verschillende typen informatie te kunnen presenteren.  
 
Men moet het podium bezitten om een presentatie in het presentatie gebied te kunnen geven. Er kan 
slechts een deelnemer in het bezit zijn van het podium. Een deelnemer beschikt over het podium als 
achter zijn naam het podium icoon is weergegeven. De icoon representeert een persoon achter een 
katheder. 
 
Indien de Sync Tabs optie is geselecteerd, zal het beeld van alle deelnemers synchroon lopen met die 
van de presentator.  
 
In de Full Screen modus worden de presentaties aan alle deelnemers op het volledige scherm 
getoond.  
 

10.1 Het White Board 

 
 

 
 

10.1.1 De knopen van het White Board 

 
Boven het White Board treft men diverse knoppen en iconen aan. De meeste knoppen zullen wel 
bekend voorkomen. Van rechts naar links treft men aan: 
 

• De Save White Board knop ;  Met de Save White Board knop kan men de inhoud van het 
White Board opslaan.  

• De Print White Board knop ;  Met Print White Board kan de inhoud van het White 
Board worden afgedrukt. 

• De Remote Mouse Pointer knop ;  Als deze knop is geselecteerd, kan de presentator een 
gele pijl gebruiken om punten op het scherm aan te wijzen. De pijl zal ook voor de overige 
deelnemers zichtbaar zijn. 

• De Clear the White Board knop ;  Deze functie wordt gebruikt om het White Board 
schoon te poetsen. 

• De Drawing tools knop ;  Met deze knop kan men een venster met schrijfgerei openen 
voor het White Board. In de pennenbak treft men een selectie aan van: lijnen, autovormen, 
een palet met diverse kleuren, etc. Het venster van de pennenbak kan op elk gewenste plek op 
het White Board worden geplaatst. Alle PowerPoint presentaties, foto’s of andere 
afbeeldingen op het White Board zijn met het schrijfgerei te accenturen of te markeren. De 
originele presensaties, foto’s of afbeeldingen zijn weer te herstellen met de Edit > Picture 
(remove annotations) functie. 
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10.1.2 Present, Show, Send 

 
De functies Present, Show, Send zijn te vinden in het File menu. Door te klikken op File > 
Present, Show, Send zal het onderstaande venster verschijnen. 
 

 
 

10.1.2.1 Toon een foto of afbeelding 

 
Na het selecteren van Show a Picture wordt er een venster geopend, waarmee men de PC kan 
doorzoeken op bestanden van afbeeldingen of foto’s. Selecteer de gewenste afbeelding of foto van de 
lokale  schijf en klik op Open om deze op het White Board weer te geven. 
 

10.1.2.2 Presenteer een PowerPoint  

 
Door het klikken op File > Present, Show, Send en dan op Present a PowerPoint slide show 
wordt een venster geopend, waarmee men op de lokale  PC PowerPoint bestanden kan selecteren. 
Open het geselecteerde PowerPoint bestand door de klikken op Open.  De PowerPoint presentatie 
wordt dan geladen op het White Board.  
Men kan op drie manieren van de ene naar het andere blad van de PowerPoint presentatie gaan: 
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De eerste methode is door gebruik te maken van de blauwe pijlen  bovenin het White Board.  
De tweede methode is het gebruik van de toetsten met pijlen op het toetsenbord van de PC.  
Bij de derde methode kan men de lijst van bladen (slides) openen door te klikken op het pijltje links 
naast de bij punt 1 genoemde blauwe pijlen. Selecteer het gewenste blad en druk dan op de Enter 
toetst. 
 

 
 
Zeer grote en complexe PowerPoint presentaties zullen meer tijd vergen om te worden weergegeven 
op het White Board. Het kan dan wenselijk zijn om de presentatie te converteren naar een kleiner 
formaat.  
Voor het converteren van de PowerPoint presentatie moet men met de rechtermuis toets op het 
White Board klikken. Opmerking dit werkt niet als het Drawing tools venster is geopend. 
Er verschijnt een nieuw venster waarmee men de PowerPoint presentatie kan aanpassen. 
 

 
 
Het is altijd aan te bevelen om bij het maken van een presentatie de omvang van het bestand te  
beperken, door niet te veel gebruik te maken van grafische of multimedia objecten in de presentatie. 
 

10.1.3 Een dia presentatie geven. 

 
Door het klikken op File > Present, Show, Send en daarna op Present an Image slide show 
wordt een venster geopend, waarmee men op de lokale PC folders met afbeeldingen of foto’s kan 
selecteren. Met een klik op Ok  worden de afbeeldingen of foto’s op het White Board geladen. 
Hiermee is het mogelijk aan de deelnemers in de sessie een dia presentatie met foto's of afbeeldingen 
te geven. 
 

• Met de  Slide Sorter functie kan men vervolgens de afbeeldingen of foto’s, indien gewenst, 
eerst op volgorde zetten. Door te klikken op het Slide Sorter icoon zal het Slide Show 
Organizer venster op het White Board verschijnen.  
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• Met de blauwe pijlen kan men vervolgens de bestanden op volgorde zetten.  
• Met het groene +-teken kan men afbeeldingen of foto’s toevoegen en met het rode x-teken 

kan met afbeeldingen of foto’s verwijderen.  
• De Reset kan men gebruiken om de afbeeldingen en foto’s van het White board te 

verwijderen.  
• Met een klik op de Save knop wordt het venster afgesloten en de nieuwe instellingen worden 

bewaard.  
• Met Cancel wordt het venster afgesloten zonder de nieuwe instellingen te bewaren. 

 

 
 
 

10.1.4 Multi media file presenteren 

 
Door het klikken op File > Present, Show, Send en daarna op Present Multi Media Files  wordt 
een venster geopend, waarmee men op de lokale  PC multi media bestanden kan selecteren. Met een 
klik op Ok wordt de file geopende en naar de overige deelnemers verzonden. 
 
De deelnemers kunnen de files afspelen met een Windows Multi Media Player versie 9 of hoger.  
 
Multi media files kunnen erg groot zijn en daardoor, afhankelijk van de snelheid van de 
Internetverbinding, erg veel tijd in beslag nemen om te uploaden. Dit zal in het bijzonder gelden voor 
inbelverbindingen. Er wordt daarom aanbevolen om geen files op het White Board te gebruiken die 
groter zijn dan 20 Mbytes.  
 
 

10.1.5 Bestanden versturen 

 
Met de Send a file functie kan men een bestand naar elke deelnemer in de sessie zenden. De functie 
wordt geactiveerd door de klikken op File > Present, Show, Send > Send a File.  Hiermee wordt 
het  Send a File  venster geopend.  
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Met Select kan men vervolgens navigeren naar het gewenste bestand. Men kan kiezen voor het 
verzenden naar alle deelnemers (klik dan op Everyone) of voor een selectie van de deelnemers in de 
sessie.  
Door op Send  te klikken wordt het bestand verzonden.  
Alle geadresseerde deelnemers ontvangen dan een bericht dat zij een bestand hebben ontvangen. De 
betreffende deelnemers kunnen het bestand vervolgens opslaan.  
 

10.1.6 Het plakken op het White Board 

 
Met de Paste Picture functie is het mogelijk om de inhoud van het klembord van de lokale  PC te 
plakken op het White Board. Met kan bijvoorbeeld een fragment uit een Word file kopiëren en deze 
plakken op het White Board. Dat men vervolgens met de deelnemers kan bespreken. Het is tevens 
mogelijk om met de White Board Drawing tools markeringen daarin aan te brengen.  
 
Voor het plakken wordt gebruik gemaakt van de Edit > Paste Picture menu functie.   
 

 

10.1.7 Screen-casting 

Deze functie is beschikbaar voor deelnemers die beschikken over het Podium .  De deelnemer 
heeft de beschikking over het Podium indien achter zijn naam het podium icoon zichtbaar is.  
 
Screen casting maakt het mogelijk om programma’s te demonstreren, bestanden op te zoeken of 
programma’s te gebruiken, terwijl de overige deelnemers de acties volgen op hun eigen PC. Men kan 
alle informatie op de computer delen met de overige deelnemers. Het is zelf mogelijk om de besturing 
van de computer aan een andere deelnemer over te dragen. Dit is een goede manier om gezamenlijk 
aan een document te werken. 
 
Er zijn 3 vormen van Screen casting beschikbaar: 
 

1. Screen-cast the Desktop;  
Deze optie dient alleen te worden gebruikt als men applicaties, die op het bureaublad actief 
zijn, wil tonen. Elk open venster op het bureaublad kan worden getoond. Bij vertrouwelijke 
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informatie is het dus verstandig om een aantal vensters te sluiten of te verkleinen voordat men 
deze functie wil gebruiken. De functie is verder heel goed te gebruiken bij het presenteren van 
informatie dat niet in een PowerPoint is gezet. Het kan ook goed van pas komen bij het 
presenteren van Internet applicaties, die gebruik maken van pop up vensters. 

 
2. Screen-cast any Active Window; Deze functie is handig wanneer men verschillende 

toepassingen na elkaar wil laten zien. Elke actief venster kan worden getoond. Dus als u 
bijvoorbeeld klikt op het venster van de HILIS vergaderruimte, dan zal dat worden getoond op 
het White Board.  

 
3. Screen-cast Application; Hiermee heeft men de mogelijkheid om een geselecteerde 

toepassing te tonen. Als de toepassing gebruik maakt van pop-up venster en men wil die ook 
in het actieve venster tonen, dan dient de selectie “Screen-cast Windows separately”  te 
worden uitgezet. 

 
Om een Screen-cast te beginnen moet men de volgende stappen uitvoeren: 

• Stap 1: 
Om met screencasting te beginnen, klikt men op File > Present, Show, Send > 
Screen-cast of op de Screen-cast knop op het White Board. Men dient de 
beschikking te hebben over het podium om de Screen-cast te kunnen activeren.  

 
• Stap 2: 

Maak eerste een keus uit wat te presenteren. Men kan kiezen uit: ”Screen-cast the 
Desktop of Screen-cast any active window”. In het laatste geval dient men te 
klikken op de naam van het venster dat men wil presenteren. 
De overige deelnemers kunnen nu mee kijken hoe u van het ene naar de nadere 
programma gaat. Alle muis en cursor bewegingen zijn nu zichtbaar voor de 
geselecteerde deelnemer.  

 
• Stap 3: 

Om Screen-cast te stoppen, klikt men op het bewegende video camera icoon rechts 
onder in de Windows Taakbalk.  

 

 
 
Het bovenstaande venster verschijnt. Door op stop te drukken wordt de Screen-cast gestopt. Men 
kan kiezen voor het tijdelijk stopzetten door de klikken op “Pause”. Met “Resume” wordt de 
Screen-cast weer hervat. Bij een pauze zal het beeld op het White Board blijven staan. Men kan dit 
beeld eventueel gebruiken voor het voren van discussies, waarbij de “Paint tools” beschikbaar zijn.  
 
Opmerking: Screen casting kan traag zijn in de overdracht van de beelden. Dit is afhankelijk van de 
Internetverbinding. Inbelverbindingen zullen vaak te traag zijn. Bij het presenteren dient men 
rekening daarmee te houden. Het kan dan wenselijk zijn om wat langzamer door de presentatie te 
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gaan, om ervoor te zorgen dat elke deelnemer dezelfde pagina kan zien. Het is verder aan te bevelen 
om specifieke toepassingen te tonen en niet het volledige bureaublad. Omdat de deelnemers anders 
alle eventuele privé informatie zouden kunnen zien.  
 
De afbeelding hieronder laat het beeld op het White Board van de deelnemers zien, in het geval van 
Screen casting. 
 

 
 
 
Wanneer gekozen wordt voor het delen van een toepassing met een andere deelnemer, verkrijgt de 
andere deelnemer de controle over de toepassing. Deze kan dan bijvoorbeeld tekst invoeren in een 
MS Word bestand. De deelnemer kan alle actie uitvoeren die mogelijk zijn op de PC waar de 
toepassing actief is. Bij het delen van het bureaublad draagt men in feite de besturing van de PC over 
aan de andere. 
 
 

10.1.8 Remote Control  

 
De Remote Control functie is erg handig voor het leveren van technische ondersteuning. Een 
helpdesk medewerker kan daarmee op afstand de besturing van een PC over nemen. 
 
De Host of Cohost kan aan iedere deelnemer het verzoek doen om de besturing van de PC over te 
nemen. De betreffende deelnemer moet in dat geval het wel podium hebben. Alvorens de Remote 
Control te activeren zal de Host of Cohost dus eerst het podium moeten overdragen. 

 
 
Het gebruik van de Remote control functie gaat met de volgende 4 stappen: 
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1. Vanuit de deelnemers lijst geeft u het podium aan de persoon aan wie gevraagd zal worden 

om de besturing van de PC over te nemen, door te klikken op het veld rechts van de naam van 
de deelnemer.  

 
2. Klik met de rechter muis toets op de naam van de deelnemer en selecteer Host / Cohost 

Options.  
 

3. In het pop-up venster wordt Request Remote Control geselecteerd. Bij de betreffende 
deelnemer verschijnt nu een Pop-up venster waarin wordt gevraagd om de besturing van de 
PC over te geven. Als de deelnemer akkoord gaat, zal zijn bureaublad zichtbaar worden. De 
Host of Cohost heeft nu de beschikking over de besturing van de PC. 

  
4. Om de Remote Control te beëindigen kan de deelnemer klikken op F10. Indien de Host of 

Cohost het podium bij de deelnemer wegneemt, zal de Remote Control ook worden 
beëindigd.  

 
 

10.2 Het Message Board 

 

 
 
Het Message Board wordt gebruikt om berichten te plaatsen of documenten op te slaan. Alle 
documenten worden automatisch gescanned op de aanwezigheid van virussen.  
 
De toegang tot het Message Board kan worden verkregen vanuit een bijeenkomst of vanaf de HILIS 
Internet site. Voor elke geplande bijeenkomst, een vergadering of online les zal automatisch een 
Message Board worden gecreëerd. Die bijvoorbeeld kan worden gebruikt om documenten te 
distribueren, voorafgaande aan de bijeenkomst.   
 

 
 
Bij het binnen gaan van de bijeenkomst en het openen van het Message Board zal een lijst van alle 
beschikbare Message Boards verschijnen. Het is nu mogelijk een te selecteren of een nieuwe 
creëren.  
 
Aan de deelnemers kan toegang tot een Message Board worden verleend. De termijn voor de 
toegang tot het Message board is instelbaar. 
  

10.3 Het Web Board 

 
Met het Web Board kan men de deelnemers in een online sessie laten deelnemen aan een Web 
tour. Het Web Board heeft dezelfde bekende functies als een Internet browser.  
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10.3.1 De Sync-URL functie 

  
Zodra de Sync-URL functie  is geactiveerd, zullen alle deelnemers in de sessie dezelfde 
Internet pagina te zien krijgen die op de PC van de presentator verschijnt. Hierbij worden er vanuit de 
PC van de presentator browser commando naar de PC van de overige deelnemers gestuurd, waardoor 
de browsers naar dezelfde pagina's worden gedirigeerd. 
 

10.3.2 Het Internet adres venster 

 
In het Internet adres venster (Address) kan een Internet adres worden getypt of geplakt.   

Door een klik op de blauwe  Go pijl of door het drukken op de Enter toets zal naar het gewenste 
adres worden genavigeerd.    
 

10.3.3 De Favorieten 

 

Het venster voor de Favorieten wordt geopend, door de klikken op het Favorieten  icoon. In dit 
venster zullen alle Favorieten in de Internet Explorer favorieten folder zichtbaar zijn. Men kan nu een 
adres selecteren en op Done klikken. Er zal dan een Internet pagina op het Web Board worden 
geopend. Het openen van een Internet pagina kan ook worden gedaan door te dubbelklikken op het 
adres in de  Favorieten folder.  
 
De presentator en elke deelnemer aan de sessie kunnen het Internet adres in hun eigen Favorieten 
folder opslaan. Dit wordt gedaan met de save a page (Toevoegen aan Favorieten) functie. Klik 
met de rechtermuis toets ergens op het Web Board. Er zal dan een pop-up scherm verschijnen. Klik 
vervolgens op Toevoegen aan Favorieten om het adres  aan de lijst van Favorieten toe te voegen.  
 

10.3.4 De Volledige Scherm modus 

 
De Full Screen of Volledige Scherm modus wordt geactiveerd door een vinkje te zetten in het vakje 

Full Screen . De Internet pagina's zullen nu over het volledige scherm zichtbaar zijn.  De 
instelling kan worden gewijzigd door het verwijderen van het  vinkje. 

10.3.5 Het vernieuwen van een Internet  pagina 

 

Internet pagina's worden vernieuwd door te klikken op het  Refresh Page icoon of Vernieuwen 
Icoon. Het klikken op het Vernieuwen icoon zal de Internet pagina opnieuw vanuit de bron laden. 
Hiermee worden alle vernieuwingen getoond sinds de laatste keer dat de pagina was opgevraagd. 
 

10.3.6 De Vorige en Volgende pagina 

 

Met de  Browse Arrows ,  de Vorige en Volgende  pijlen kan men, ten opzichte van de huidig 
zichtbare pagina, naar de vorige of de volgende pagina gaan.  Let op; men kan alleen naar een vorige 
of volgende pagina gaan, indien die pagina's al zijn bezocht. 
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10.3.7 Het kopiëren van een pagina 

 

Met het Copy icoon  kan men een kopie van een Internet pagina maken en deze opslaan in het 
Klembord van de PC. De presentator, houder van het Podium, kan deze pagina vervolgens kopiëren 
op het White Board. Dit wordt gedaan door het klikken op de White Board Tab en dan te klikken 
op Edit > Paste Picture.  Zodra de afbeelding van het Web Board op het White Board is 
gekopieerd, is deze statisch geworden. Het is dus niet meer live. Men kan nu wel gebruik maken van 
de Paint tools om de afbeelding te accentueren of te markeren. 
 
Door de View Only modus in het Options menu te selecteren kan men het zelfstandig navigeren van 
de overige deelnemers blokkeren.  Indien de View Only uitstaat kunnen de deelnemers zelfstandig 
navigeren.  
 

10.4 Het Chat Board 

 
Met het Chat Board hebben de deelnemers aan een bijeenkomst de beschikking over een groot 
scherm voor tekst chats. Dit kan onder meer aan het eind van een bijeenkomst worden gebruikt voor  
het geven van terugkoppeling, het stellen van vragen, het geven van antwoorden, etc. In dit  geval 
zou het kleine Group Chat venster minder goed passen. 
  
Zodra het Chat Board wordt geopend zal alle tekst uit het Group Chat venster worden gekopieerd 
naar het Chat Board en het Group Chat venster is niet meer zichtbaar.  
 
De presentator kan alle deelnemers leiden naar het Chat Board. Hiermee een prima platform wordt 
gecreëerd voor het afronden van een bijeenkomst.  
 

 
 

10.4.1 Het openen van het Chat Board 

 
Het Chat Board wordt geopend door te klikken op de Chat Board Tab. Om alle deelnemers naar het 
Chat Board te leiden dient Sync-Tabs te zijn aangevinkt.  
Indien de presentator naar een andere Board wil overschakelen, zonder de deelnemers daarin mee te 
nemen, zal hij tijdelijk het vinkje bij Sync-Tabs moeten verwijderen. Anders zullen de deelnemers de 
acties door de overige deelnemers kunnen worden gezien. 
 

10.4.2 Het Basis Chat Board 

 
Bij het openen van het Chat Board staat deze standaard ingesteld als Basic Chat Board  (basis 
Chat board). Het Basic Chat Board bevat alle standaard chat functies die men in het reguliere Chat 
venster terug kan vinden. De deelnemers zien de teksten van de chat berichten en de namen van de 
afzenders in het chat venster.  Elke deelnemer kan nu teksten in het tekstvlak onderin het scherm 
typen en deze verzenden door op de Enter toets van het toetsenbord te drukken. 
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Indien een deelnemer naar een ander Tab navigeert, zal het Chat Board weergegeven worden in het 
reguliere Chat venster. Alle teksten zullen daarin zichtbaar blijven.  
 

10.4.3 Het Geavanceerde Chat modus  

 
Zodra het Chat Board wordt geopend, staat deze standaard ingesteld op de Basic Chat  Board. Alle 
deelnemers kunnen chat teksten verzenden door het typen van de teksten in het tekst vlak onderaan 
het scherm en op de Enter toets van het toetsenbord te drukken.  
 
Met de geavanceerde Chat optie, Advanced Chat Options, kan de presentator berichten van andere 
deelnemers verbergen. Het is ook mogelijk om de namen van de afzenders te verbergen. Dit is van 
belang wanneer men gevoelige informatie wil uitwisselen of wanneer de presentator om kritische 
commentaar vraag en de personen die reageren hun berichten niet naar de andere deelnemers willen 
verspreiden of anoniem willen blijven. 
  

  

10.4.4 Berichten alleen zichtbaar bij de presentator 

 
In het venster Presenter Options kan de presentator klikken op Force Responses to be Private. 
Bij het selecteren van deze optie zullen alle berichten van alle deelnemers alleen maar zichtbaar zijn 
bij de presentator.  Met het uitzetten van deze optie zullen alle berichten die verder worden 
verzonden weer voor de deelnemers zichtbaar zijn.  
 

10.4.5  Berichten anoniem verzenden 
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Bij de optie Allow Anonymous Responses wordt de mogelijkheid gegeven om anonieme berichten 
te verzenden. Deze functie wordt aangezet door de optie Allow Anonymous Responses aan te 
klikken. 
 

 
 
Bij de deelnemers zal nu rechts onder in het scherm een venster verschijnen met als titel 
Anonymous. Elke deelnemer heeft met het aanvinken van deze optie de keuze om berichten 
anoniem te verzenden. In plaats van de naam van de afzender, zal nu het woord Anonymous voor 
elke tekst worden getoond.   
 

 
 
De presentator heeft verder de mogelijkheid om alle tekstberichten anoniem te maken. Dit wordt 
gedaan door het vinken van de optie Force Anonymous Responses.  
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11 Lijst van Engelstalige benamingen, woorden en begrippen  

 
 
 
Item Naam Omschrijving  Referentie  
1 Abstain Van stemming 

onthouden 
 7.5 

2 Add Voeg toe  3.1 

3 Add Voeg toe  6.4.1 
4 Advanced Chat 

Options 
Verfijnde Chat Opties  10.4.3 

5 Allow Anonymous 
Responses 

Activeer anonieme 
chat teksten 

 10.4.5 

6 Allow people to "grab" 
the microphone 

Sta deelnemers toe de 
microfoon te over te 
nemen. 

 6.4.2 

7 Allow people to “grab” 
the podium 

Sta deelnemers toe 
het podium over te 
nemen 

 6.4.2 

8 Allow people to doodle 
on the White Board 

Sta deelnemers toe op 
het White bord te 
schetsen 

 6.4.2 

9 Allow people to erase 
the White Board 

Sta deelnemers toe 
het White bord te 
wissen 

 6.4.2 

10 Allow people to private 
chat with each other 

Maak privé chat 
mogelijk 

 6.4.2 

11 Audio delay Geluidsvertraging  5.2.1  

12 Audio settings Audio instellingen  5.2 

13 Auto-select Sync Tabs 
when podium is 
passed 

Selecteer 
automatische 
synchronisatie 
wanneer het podium 
wordt overgedragen 

 6.4.2 

14 Auto-select Sync URL 
when podium is 
passed 

Selecteer 
automatische 
synchronisatie van de 
link wanneer het 
podium wordt 
overgedragen 

 6.4.2 

15 Basic Chat Board Basis chat bord  10.4.2 

16 Browse Arrows Navigeer pijlen  10.3.6 
17 Cancel Annuleren  5.3 

18 Charge Time to Kosten doorbelasten 
aan 

 2.3.2 

19 Chat board Chat bord  10.4.1 
20 Chatting with ..  Chatten met ..   7.6.2 

21 City Stad  2.3.2 
22 Clear All Verwijder alles  6.4.1 

23 Cohost Vice Voorzitter  6.4.5 

24 Copy Join link to 
clibboard 

Kopieer de Join link 
naar het klembord. 

 6.4.1 
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Item Naam Omschrijving  Referentie  
25 Copy Picture Kopieer afbeelding  6.2 

26 Create new Account Open een nieuw 
Account 

 2.1 

27 Device Apparaat 5.2.1 
28 Disble podium 

grabbing 
Maak podium nemen 
onmogelijk 

 2.3.3 

29 Dismiss [..] form 
meeting 

Verwijder deelnemer 
uit vergadering 

 7.6.3.2 

30 Done Gereed  2.3.3 

31 Edit Bewerk  4.1 
32 Evaluation form Evaluatie formulier  2.3.2 

33 File Bestand  4.1 

34 Force Anonymous 
Responses 

Maak alle chat teksten 
anoniem 

 10.4.5 

35 Force Responses to be 
Private 

Maak alle chat teksten 
privé  

 10.4.4 

36 Future Events Toon geplande 
bijeenkomsten 

 

37 Full Screen Volledig  Scherm  6.3 
38 Gamma, contrast & 

hue 
Gamma, contrast & 
kleur 

9.3.3 

39 Group Chat Groeps Chat 8 
40 Headset Hoofdtelefoon met 

microfoon 
 5.1 

41 Host Innitator of voorzitter 
van de vergadering 

 2.3.2 

42 Host a Scheduled 
Event 

Start een geplande 
bijeenkomst 

 

43 Host a Meeting Start een bijeekomst  2.3 
44 Host Details Instellingen voor de 

voorzitter 
 2.3.2 

45 Host Name Naam van de 
voorzitter 

 2.3.2 

46 I am using a 
microphone headset 

Ik gebruik een 
headset met 
ingebouwde microfoon 

 5.2.2 

47 I want this room to be 
unlisted 

Geen vermelding in de 
list van lopende 
vergaderingen 

 2.3.1 

48 Join an unlisted 
meeting 

Ga naar een 
vergadering  niet in de 
lijst 

 3.3 

49 Join Meetings & 
Events 

Ga naar een 
vergadering 

 3.2 

50 Live Events Toon lijst van 
bijeenkomsten 

 2.3.1 

51 Lock the Meeting Vergrendel de 
bijeenkomst 

 6.4.6 

52 Log-om Aanmelden  2.3 

53 Meeting Duration Tijdsduur van de 
vergadering 

 2.3.2 

54 Meeting ID Identificatie van de  3.3 
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Item Naam Omschrijving  Referentie  
vergadering 

55 Meeting Recorder Bijeenkomst 
registratie. 

 6.4.8 

56 Meeting Room 
Password 

Wachtwoord 
vergaderruimte 

 2.3.1 

57 Message board Prikbord  2.3.2 
58 Message Board Elektronisch prikbord  10.2 

59 Microphone Test Microfoon testfunctie  5.2.3 

60 More Options Overige opties  2.3.3 
61 Multimedia Settings Multi media 

instellingen  
 5.2.3 

62 My Account Mijn Profiel  
63 Options Opties  4.1 

64 Organization Naam organisatie 
voorzitter 

 2.3.2 

65 Paint Tools  Schrijf en tekengerei  10.1.7 
66 Participant must 

provide BOTH first and 
last name 

Deelnemers moeten 
voor en achternaam 
opgeven 

 6.4.2 

67 Participant must 
provide city / state 

Deelnemers moeten 
de  provincie of staat 
van vestiging 
opgeven. 

 6.4.2 

68 Participant must 
provide e-mail address 

Deelnemers moeten 
hun e-mail adres 
opgeven 

 6.4.2 

69 Participant must 
provide organization 
and title 

Deelnemers moeten 
de naam van hun 
organisatie en titel 
opgeven 

 6.4.2 

70 Participant must 
provide phone number 

Deelnemers moeten 
hun telefoonnummer 
opgeven 

 6.4.2 

71 Participants grid Deelnemersvenster  7.1 

72 Participants Limit Maximum aantal 
deelnemers 

 2.3.2 

73 Paste Picture Plak afbeelding  6.2 

74 Performance Prestatie  6.4.2 

75 Please Answer Yes or 
No 

Antwoord Ja of Nee  7.5 

76 Podium Podium  2.3.3 

77 Polling – Post a 
Question 

Opiniepeiling - stele 
en vraag 

 7.5 

78 Post the Question Stel een vraag  7.5 
79 Present a PowerPoint 

slide show 
Presenteer een 
PowerPoint presentatie 

 6.1 

80 Present an Image slide 
show 

Presenteer een aantal 
afbeeldingen 

 6.1 

81 Present Multimedia;  Presenteer een multi 
media presentatie 

 6.1 

82 Presenter Options Opties voor de 
presentator 

 10.4.4 
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Item Naam Omschrijving  Referentie  
83 Print Bestand afdrukken   6.1 

84 Private Polling Privé opinie peiling  7.5 
85 Private Room Besloten vergadering  2.3.1 

86 Promote to Cohost Bevorder tot vice 
voorzitter 

 7.6.3.2 

87 Public Room Publieke vergadering  2.3.1 
88 Purchase Time Tijd inkopen  2.2 

89 Refresh Page Vernieuw de pagina  10.3.5 
90 Refuse Private Chats Weiger privé chat  7.6.1 

91 Remote Control Besturing van PC op 
afstand 

 10.1.8 

92 Remove Verwijder   6.4.1 
93 Request Remote 

Control 
Verzoek tot 
overnemen besturing 
PC 

 10.1.8 

94 Restore Picture Herstel Afbeelding  6.2 

95 Restrict participants to 
view only mode 

Beperk de deelnemers 
tot alleen kijken en 
luisteren 

 6.4.2 

96 Room Details Detail instellingen van 
de vergaderruimte 

 2.3.1 

97 Room Settings Instellingen 
vergaderruimte 

 6.4.2 

98 Save Picture Bestand opslaan   6.1 

99 Save Settings Sla instellingen op  6.4.2 

100 Screen-cast Toon het scherm  6.1 
101 Send a File Zend een bestand  6.1 

102 Send Meeting 
Invitations 

Stuur een uitnodiging  3.1 

103 Send Now Verstuur nu  3.1 

104 Send Now Verstuur  6.4.1 

105 Show a Picture Toon een afbeelding  6.1 
106 Show Group Chat 

control 
Toon Groep Chat 
venster 

 6.3 

107 Show Received Files Toon ontvangen 
bestanden 

 6.4.7 

108 Show Webcam control Toon Webcam venster  6.3 
109 Size & pixel depth Afmeting en beeldpunt 

resolutie 
 9.3.2 

110 Sounds Geluid  7.6.1 

111 Start the Meeting Start de vergadering  2.3.3 
112 State Provincie  2.3.2 

113 Submit Verzenden  2.1 

114 Submit Feedback Terugkoppeling 
verzenden 

 7.6.1 

115 Sync Tabs Synchronisatie Tabs  6.4.2 

116 Sync-URL Synchroniseer 
Internet adres 

 10.3.1 

117 Talk Spreekknop  5.1 
118 Telephone Telefoonnummer  2.3.2 

119 Title Titel of functie  2.3.2 
120 Toggle My Away Schakel over op  7.6.1 
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Item Naam Omschrijving  Referentie  
Status afwezig 

121 View Beeld  4.1 

122 Vioce Chat  Video Chat  7.6.2 

123 Volume Geluidsterkte  5.2.1 
124 Web Board Internet toegang in 

sessie 
 10.3 

125 White Board Elektronisch White 
board 

10.1 

126 Windows Styles Schermindeling  6.3 
 
 
 
 
 


